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How to Add Text to a PDF File

To add text to a PDF, follow these 4 steps:


1. Download and install PDFChef by Movavi.
2. Run the program and add the PDF you want to add text to.
3. Click Edit, choose Text, select the place to add a text block on the page, and type in the text you want to add.
4. To save the edited text, click Save.
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By clicking the download button, you're downloading a trial version of the program.*
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Have you ever wanted to make changes to your PDF file? Or are you wondering how to insert text in PDF? You’re not alone. As one of the most popular document formats, PDF files can be challenging to modify. Without the right software, it can be difficult to edit or add text to your PDF file.
If you are to add text to your PDF file, PDFChef is the best solution out there. It is a comprehensive tool that serves as a cross-platform app for both; Windows and Mac computers. With this tool, you can edit existing text, manage pages, add signatures, include images, and accomplish a lot more with absolute ease.




How to add a text box to a PDF and insert text



Step 1. Download and install the program


Download and run PDFChef executable on your PC or Mac and follow the on-screen instructions.
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Step 2. Import a PDF file


Start PDFChef, click Open File in the middle of the program window, and select the PDF document you want to type into. You can also use drag-and-drop to add files to the workspace.








Step 3. Add a text box to a PDF and enter your text


Click Edit on the left side of the toolbar to switch to the Edit mode. Choose the Text option from the drop-down. Move the insertion point to the location in the document where you want to place the added text field to the PDF.







In the fillable text box in your PDF, enter the desired text. Newly inserted text is editable. You can change the text and font properties using the options under Font in the right-hand panel.








Step 4. Save your edits


Once the edits are complete, save the document by clicking the Save As command from the File menu. In the Save As dialog box, you can enter the file name and choose the destination folder. Click Save and enjoy the results!







If adding text to a PDF is not supported in your current software, you might have better luck with PDFChef! Try it now, and you won’t be disappointed.







PDFChef by Movavi


Everything you need from PDF software!
Download for FreeAbout the Windows version
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* The trial version of PDFChef by Movavi has the following restrictions: 7-day trial period, watermark on the output PDF. 






How to insert text in a PDF online


If you don’t want to download software that allows you to add text to your existing PDF document, Smallpdf is the best online tool to add text to the PDF directly in your browser.
It is a web-based app that enables you to make PDF file changes without downloading them into the system. Smallpdf has an easy-to-use interface that makes it simple for anyone to navigate the tool and add text to the PDF file.
As a browser-based application, it is supported by Windows, Mac, and Linux devices. Smallpdf makes it easy for you to add text quickly by providing you the option to import the file straight from your Google Drive or Google Drive. This enables splitting, merging, and converting files into PDF easily through its drag and drop functionality.
Moreover, with its digital signature feature, you can sign contracts, request digital signatures, and even close deals quickly. But it does not allow you to change or format the pre-existing text in the file. Smallpdf only enables you to add more text to the pre-existing file.






Step 1. Go to Smallpdf.com


If you want to add text into an existing PDF file, go to Smallpdf.com.
Smallpdf’s official website







Step 2. Upload your PDF file


Drag and drop the PDF document into the Smallpdf editor or select the PDF file you want to edit by clicking on Choose File at the top of the screen. Click on the PDF you want to edit and click Open.








Step 3. Start adding text


Scroll to the part of the PDF where you want to add text and click the Add Text icon that looks like a T on the left side of the toolbar.








Step 4. Click the mouse to place the text box


Drag the text box to the desired location and start adding text to the document.








Step 5. Download the changes


When you insert text into the file, you can save the changes by saving to the device, Smallpdf, Dropbox, or Google Drive. You can even download the changed document, print it, or share the file with others through a link generated by Smallpdf.









How to add text to a PDF on a Mac


Do you want to edit a PDF file on a Mac to add more information? We are here to show you how you can edit a PDF on a Mac using two essential tools that help you finesse the completed PDF document. PDFChef is one such comprehensive tool that allows you to edit, merge, split, rotate, and modify your PDFs on Mac. It also helps you manage your PDF-related tasks securely as it is free from any malware that can damage your device.
Preview is another app that comes with the Mac operating system and allows you to edit PDFs on your Mac for free. It offers all the features provided by professional PDF editing software, including the extraction of single pages out of multiple pages’ documents or dragging and dropping single and numerous pages into documents.




Adding text to a PDF on a Mac with Preview


Here’s how you can add text to a PDF document on a Mac using the Preview app.






Step 1. Open the PDF with Preview


Right-click on the PDF file that you need to edit, choose Open With, and select Preview.








Step 2. Choose the editing option


Select the pen icon on the top right-hand side of the screen to open the toolbar. Click on the A icon that presents a text box on the PDF document.








Step 3. Start adding the text


Start inserting the text that you want to add in the text box. You can even choose the font, color, size, or anything else you need when you click on the A option.








Step 4. Save the edited PDF document


After making all the necessary edits, save the PDF yourself. Or Preview will do that for you once you close the document.









Adding text to a PDF using PDFChef by Movavi for Mac


If you are looking for a more professional tool to edit a PDF, PDFChef by Movavi for Mac is the best solution. Here’s how you can add text using this tool.






Step 1. Download and install PDFChef by Movavi


Head over to the tool’s website and download PDFChef on your Mac. When the download is complete, run the software and follow the screen's instructions to complete the installation.







Step 2. Open the PDF file in PDFChef


Open the software and click on the Open File option in the middle of the window. Choose the PDF document you want to insert text in. You can also drag and drop the file into the program window.








Step 3. Insert a text box and start adding text


After opening the document, click Edit present on the left side of the toolbar. Select the Text option from the drop-down that appears on the top middle of the screen. 







A text box is displayed on the screen that you can then drag to the document's location where you want to add text. You can also change the text's fonts after selecting the Font option from the panel's right side.








Step 4. Save your edited PDF document


Once you are done with all the edits, save the document through the Save As option in the File menu. When the Save As dialog box appears, enter the desired file name, select the folder where you want to save it, and click Save.









How to add text to a PDF with Adobe® Reader®


If you want to add text to a PDF file using Adobe® Reader®, you will be disappointed to learn that it does not allow you to edit PDF files. But Adobe® Acrobat® Pro, a paid version of Adobe® Reader®, offers this option.
Adobe® Acrobat® Pro offers a comprehensive set of tools to edit your PDF documents and add text. Its text editing tools allow you to select the font, kerning, paragraph alignment, superscript and subscript placement, bullets, and a lot more. All the features offered by this platform are tools that you are already familiar with, which means you can smoothly add text to your PDF document.




Adding text to a PDF using Adobe® Acrobat® Pro


Here’s our step by step instructions on adding text to your PDF document in Adobe® Acrobat® Pro.






Step 1. Open Adobe® Acrobat® Pro


Start the Adobe® Acrobat® Pro program and select the Tools tab present on the screen's top left side. Click on the Edit PDF option.








Step 2. Create a text box to add the text


Choose the Add Text option from the toolbar.
There are two types of text boxes that you can create to add the text: scalable and fixed-width text boxes. The scalable text boxes are aligned with the right margin and the bottom margin of the page. To create this box, place the cursor on the screen and write or paste the document's text. The fixed-width text boxes come with their original width, and you can only customize them lengthwise to accommodate the text. To create this box, move your cursor and create the box and write or paste the text in the box. You can also choose the text format such as the font size, color, text alignment, and much more.








Step 3. Save the document


Once you have added the text, go to the File tab and select Save As.









Conclusion


All the methods and tools that we have recommended here are simple to use and offer various features to make it easier for you to edit a PDF document. In the end, it all depends on your requirements.
The best option to add text to your PDF document is to download PDFChef by Movavi that protects your documents and enables you to manage and perform a range of PDF-related tasks.
Similarly, if you have limited space on your device or you want to avoid installing another application, Smallpdf is the best web-based tool out there that helps you add text to your PDF document.
If you add text to a PDF on Mac, you can either use the Preview app that comes with the Mac operating system or download PDFChef by Movavi for Mac to get access to a full suite of professional editing tools for your PDF document. If you want to insert text into a confidential PDF document, PDFChef offers encryption and secures your document.
Lastly, the final method entails adding text using Adobe® Acrobat® Pro that offers a number of text editing tools.



Frequently asked questions
How do I fill out a PDF form?

Launch PDFChef by Movavi → Import and fill out the template → Save the result
Read the full article on how to fill out forms:
How to fill out PDF forms       

How can I edit a PDF?

How to edit a PDF:
	Open a PDF in PDFChef by Movavi.
	Click Edit in the toolbar.
	If you want to add a picture, click Image, select one from your computer, and position it on the page.
	If you want to edit text, click Text, then the line you want to edit, and start typing.
	If you want to insert a signature, click Signature, draw it or upload an image with a signature, then position the image on the page.
	Finally, click Save.


Read the full guide:
How to edit PDFs       

How do I change the text on a PDF?

To change text in a PDF file, you can use PDFChef. Download and install the program, then, add the PDF-file you want to edit. Click Edit, then select the line you want to edit the text in. Type the needed text and then click Save to preserve the changes in the PDF.






Have questions?
If you can’t find the answer to your question, please feel free to contact our Support Team.
Visit Our Support Center
Visit Our Support Center

Watch Our Video Guides
Watch Our Video Guides





Similar guides
How to add a picture to a PDF       
How to make PDF files       
How to rearrange PDF pages       
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